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Multimodal applications

1

Multimodal applications
PTV Visum is a software for multimodal transportation planning with an integrated network
model for private and public transport. However, private and public transport follow different
basic principles and the approaches to modelling them are different. For example, for
private transport road categories with their speeds and capacities as well as volume-delay
functions are required, but for public transport we require time tables, stops and transfer
opportunities.
The interactions between different transport systems can be modelled and taken into
account both for demand calculations as well as for assignments of demand to a transport
network. Combining private and public transport has so far only been possible using
special features like auxiliary public transport. Another form is the newly implemented form
of vehicle sharing considered within the public transport assignment (see 2.1). However,
these approaches have some limitations such as neglecting the fact the corresponding trips
have an impact on travel times for other users.
Another example is park and ride (P+R) which is supported with a built-in procedure.
However, this is restricted because the path legs are allocated to different demand
segments with their corresponding modes and subsequently assigned. In this approach the
overall course of the path is lost.
In Visum 17, we have implemented a true basis for multimodal applications with new data
model objects as well as procedures in which paths with several modes are generated, and
further evaluations and graphical displays. Some applications are now better supported
because of these data structures and the respective procedures, for example:
 regional and national demand models
 modeling of long-distance passenger demand
 modeling of long-distance freight transport
 modelling of bicycle carriage
 display of P+R entire paths from origins to destinations
 display of tours and paths from ABM models

1.1

Multimodal assignment
In the multimodal assignment demand is assigned to a simplified network graph and the
overall paths from their origins to their final destinations (which we call a path sequence)
consist of several paths for which different modes can be used. Practical examples exist in
passenger and freight transport: for instance, a flight passenger who drives to the airport
with her own car and travels by taxi from the destination airport to the hotel. The demand
for a multimodal assignment can originate from a demand model but also other sources like
survey data are possible.
For the multimodal assignment, a simplified graph is created where available modes are
known for each edge. Furthermore, skim matrices from assignment of demand segments
from these modes are calculated. The search impedance for the multimodal assignment
can consist of different components such as time, distance, cost. The exact composition of

PTV Visum 17 - New features at a glance © PTV AG

4

Multimodal applications

these components must be defined. In case of the journey mentioned above, ‘time’ of the
total path includes travel time of the car leg, flight time, and travel time by taxi for the final
path.

From the origin of the demand data a main mode is defined, and this main mode is used
on at least one path in the path sequence. The change of mode along a path sequence can
only occur in a zone. Additional impedance components for this can be considered in the
definition of skim matrices.
A branch and bound search is used to generate a set of path sequences. This set of path
sequences can be further restricted by additional assignment parameters. The following
screenshot shows an example for such a path sequence. Both circles as well as squares
represent zones in the model. The path sequence marked in red consists of three paths.
The first can be carried out with car or rail, the second is the flight and the last path again is
by car.

After the search, the demand is distributed to possible path sequences using a logit model.
The basic principle of the multimodal assignment can be summarized by the following
figure: the multimodal assignment is based on assignments of subordinate demand
segments and corresponding calculation of skim matrices from these assignments. From
the multimodal assignment and its path sequences demand matrices can be updated and
optionally reassigned.
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For the application of the multimodal assignment, in a demand model for example, several
complementary procedures are provided, including the calculation of demand matrices
from path sequences and the calculation of skim matrices for path sequences.

1.2

Evaluations and graphical display for multimodal applications
New network objects and data structures have been developed to support the multimodal
assignment which can also be populated by other procedures or external data sources.
The most important new network objects are explained using a practical example, namely
an application of bike carriage in public transport. We assume that the demand is known
and bike carriage is restricted to LRT and tram. For the multimodal assignment, skim
matrices for both bike and public transport are needed. For the latter, the skim matrix
calculation is restricted to services on which bikes can be taken.
The multimodal assignment generates path sequences, which represent a sequence of
zones that are visited over the course of the journey. The corresponding list of path
sequences shows the origin and destination zones, volumes as well as attributes of the
overall journey. The path sequences from an assignment are stored in the path sequence
set.

The single elements of the sequence are the paths from one zone to the next zone. If the
corresponding demand segment has been assigned, the course of paths are known and
can be displayed. In the following figure, one path sequence in the network is shown. It
consists of three zones and two paths for which different modes – displayed in different
colours - are used.
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The selection in the list of path sequence items can be restricted to marked path
sequences. Additional attributes like skim matrix components can be shown.
Depending on the use case, several other attributes can be filled, e.g. when external data
from an ABM are imported. This includes e.g. activities, departure and arrival times. The
import of such data is supported by a special import procedure.
The extension of data structures also has advantages for the existing P+R procedures,
because the results of the procedure ‘P+R lot choice’ can be stored as path sequences.
This has the benefit that entire paths and their course in the network can be displayed.
Furthermore, the skim matrix calculation for path sequences enable an independent
calculation of skims for the return direction where the v/c dependent component does not
play a role.
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2

Assignment procedures

2.1

Vehicle sharing
Many major cities have already established car and/or bike sharing systems. Their
acceptance and therefore their importance in urban transport are increasing. The inclusion
of such systems in macroscopic traffic models is therefore becoming more important for
transport planners, public transport operators and providers of sharing systems.
In PTV Visum 17, the timetable-based public transport assignment has been extended to
include Vehicle Sharing. Both free-floating and station-based systems (round-trip and oneway) are supported by a new procedure.
This enables us to answer questions such as how the introduction of sharing systems will
affect the modal split and whether it will support public transport or compete with it. We can
determine the optimum balance between the numbers of vehicles, the effort required for
relocating them and the user demand, thus minimising investment in the infrastructure of
such systems.
Due to the implementation within the timetable-based assignment, it is possible to consider
standalone usage of sharing systems as well as trips combining classic public transport
and sharing systems. Multiple sharing systems can be included, so it is possible to
simultaneously model bike and car sharing systems within one model.
Additional analysis indicators such as the saturation of stations, and rental, return and
relocation processes on a time interval basis are available.

A new type of transport system ‘Sharing’ was introduced to model vehicle sharing systems.
This contains, among other things, the type of vehicle sharing system and whether the
vehicles are being relocated by the operator within the system. If a transport system of this
type is inserted into the ‘Public Transport’ mode, the time table based assignment will take
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this into account.
The second essential element is the sharing stations. The renting process begins or ends
here. A station is linked to the network via its access nodes. Stations hold the information
on their capacities, their initial as well as their optimal occupancies. Furthermore, the
additional time required for renting and returning the vehicles is defined here.
The calculation is part of the timetable based public transport assignment. Since the
vehicle and station capacities in the system are limited, the route choice is based on a
volume-dependent impedance. This leads to an iterative process, which is led to
convergence by damping the volume ratios on OD pair level.
A simplified relocated algorithm is used to relocate vehicles by the operator. It tries to
maintain the optimal occupancy of the stations and is limited by the relocation rate, but not
by travel times, distances or other costs.
Following assignment, all vehicle sharing usage is available as public transport path legs
and thus integrated in to the usual public transport evaluations. Comprehensive indicators
of the vehicle sharing usage are available at zone and OD pair level as well as globally.

2.2

PrT Assignment Bi-conjugate Frank Wolfe (BFW)
In Visum 17, a new private transport assignment procedure has been implemented. The
procedure ‘Bi-conjugate Frank Wolfe’ – short BFW – is a further enhancement of the Frank
Wolfe (FW) method. The implementation is mainly motivated as a better converging
alternative to the Lohse assignment (which is also a variant of FW).
The procedure BFW is multi-threaded, and run time scales well with the number of cores.
Compared with the Lohse assignment, BFW converges to tighter levels, i.e. instead of 1e-3
with Lohse, BFW reaches gaps of 1e-4 or even 1e-5.
The following evaluations shows how run time and convergence for BFW are compared to
other assignment methods. The tests have been carried out on a machine with 4 cores.
This is only an indication, and it should be borne in mind that both Lohse and BFW scale
with the number of cores and so run times can improve considerably compared to LUCE
and Equilibrium if better hardware is used.

In the assignment parameters of BFW, only the maximum number of iterations and the
maximum relative gap are defined as termination criteria.

PTV Visum 17 - New features at a glance © PTV AG

9

Assignment procedures

The procedure is also available as subordinate assignment method within Assignment with
ICA.

2.3

Extensions in the simulation-based assignment (SBA)
The implementation of the simulation-based dynamic assignment (SBA) generated great
interest, and generally there is more focus on dynamic models that enable more realistic
replication of junction impedances for route search and distribution. SBA has now been
extended to improve the assignment and to also cover more use cases.
The new features are related to convergence in models with long assignment periods,
better consideration of different user classes and a warm start option, i.e. a previous
assignment result is used as a starting solution.
Convergence in models with long assignment periods
In assignments which cover several hours of a day, the first iterations can produce some
artificial congestion effects which normally are resolved within a couple of iterations
because demand is redistributed to other routes. Nevertheless, this has the side effect that
in later time intervals volumes are still not correct. Once congestion is resolved in earlier
periods congestion can occur at later time periods which in contrast cannot easily be
resolved because the volumes redistributed to other routes is comparably smaller. The
following screenshot shows an example of how these effects can be observed in the
convergence measures. The red colored cells indicate high gap values which move over
iterations (y-axis) and time (x-axis).
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To allow for redistribution of more volumes in these circumstances in the assignment
parameters the time interval-dependent step size can be used.

This change is already available in a service pack of PTV Visum 16.
Better consideration of different user classes
Lanes are represented in SBA, whereby a vehicle selects a lane that allows it to follow its
route at the next junction. If several lanes are available, the decision is made based on
macroscopic quantities. In urban areas this is close to reality, but on motorways, user
classes with lower speed limits – e.g. HGV – are often required to stay in the outer lanes.
A consequence is that average speeds per lane and user class vary on such links. This
behavior can now be replicated using the option ‘SBA Use Outermost Lane Only’ for the
corresponding link types.
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Warm start based on an existing assignment result
Using the warm start option the use cases in which SBA can be applied are extended. It is
possible to investigate scenarios based on an equilibrium state in which the network and/or
demand is changed. This is useful, for example, in the investigation of planned and
unplanned events. For planned events which may include blocking of some roads or the
application of temporarily speed limits, drivers may sufficient prior knowledge to change
their original routes and in doing so a new equilibrium state will result. For unplanned
events, drivers are affected by changes but are unable to fully adapt to new routes.
In the procedure parameters the option ‘Use current assignment result as initial solution’
can be activated and the number of iterations determine how much drivers adapt to a new
state: if a single iteration is calculated as shown in the screenshot below it means that
drivers will follow the same route as before. If due to a road closure the original route is no
longer available, drivers are redistributed to other routes between the same OD pair. If
there are OD pairs for which no route is available anymore, a new shortest path search is
carried out and volumes are assigned to this route.

Alternatively, drivers have the possibility to adapt to new conditions and a new equilibrium
state can develop. In this case the number of iterations are increased and the gap
determines the termination criterion. In the following screenshots volume changes are
shown for the case that on the purple marked link a speed reduction to 10mph is applied
for a duration of 10 minutes from 6:30 to 6:40.
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It can be seen that in the scenario with the temporary speed reduction the road section
downstream of the affected link are reached later, i.e. from 6:50 onwards volumes are
higher than in the base case.
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Demand procedures

3.1

Demand matrix correction using the method of least squares
An alternative matrix correction procedure has been implemented, motivated by two reasons:
1. TFlowFuzzy cannot always produce a solution
2. The matrix correction procedure can take longer if several conditions – different types
of counts and distributions – are combined in one calculation
In the new variant ‘Least squares’ the matrix correction problem is formulated as a
nonlinear optimization problem in which the sum of squares between counts and volumes
as well as between corrected and original matrix values are minimized.
A number of different weighting factors are available: individual weighting factors for counts
and matrix values; and counts weighted relatively against matrix values. The latter means
that either the count values should be met closely or the matrix values are more important.

Like TFlowFuzzy, the new method can be used for several demand segments
simultaneously and options for defining constraints are identical. This means that the
procedure can be used for both correction of matrices of private as well as of public
transport, and different types of count values can be combined with distributions in a single
calculation.

In addition to the implementation of the method, the calculation of the flow matrix has been
significantly accelerated. Since this calculation step is used by both variants – TFlowFuzzy
and Least Squares – TFlowFuzzy is also considerably faster in Visum 17. Run time savings
depend on the number of demand segments and the constraints. In our tests, run times
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using TFlowFuzzy have at least cut by half with ‘Least Squares’ faster still.

3.2

Distribution for doubly constrained across demand strata
The objective of the doubly constrained calculation is the distribution of the attraction
potential, ideally independent of the person group, but across persons with the same trip
purpose. This approach has been implemented for the Nested demand model where
several demand strata can compete for the same attraction potential, e.g. jobs, and it is
now also available in the tour-based passenger demand model.
The settings must be defined in the demand model under ‘Activities’.

The effects of the calculation are demonstrated using the following example:
Assume there are 600 work places located in two different zones, 400 in one zone and 200
in another zone. Employees are subdivided into two person groups with and without car
availability. In reality, all employees compete for jobs in the region independent of their car
availability, and the two different person groups are only used to replicate differing aspects
of their behaviour.
The calculation of destination choice using the option ‘Couple DStrata together’ results in
the work places in the two zones being distributed among the two person groups as shown
in the following figure. Here EC means ‘employed with car’, EnC means ‘employed without
car’, the greens colours denotes the zones with work places and the blue colours denote
zones generating work trips.

The 600 work places are shared among all persons. For the zone with 200 work places, the
majority of work places are used by employees with car. The majority of people without car
work in the other zone (where 400 work places are available). With the new option, the
distribution of work places among persons belonging to different demand strata is a result
of the calculation.
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Without this option, work places are automatically distributed according to the number of
persons of different demand strata, i.e. in this example one quarter of work places in each
zone are used by persons without car (150 / 600) and three quarters would be allocated to
persons of employees with car (450 / 600).
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4.1

PTV Vision start page
From now on, all PTV Vision products; PTV Visum, PTV Vissim and PTV Vistro will
welcome you with a new start page. This central page allows you to easily access recently
opened files as well as all PTV user help channels. The start page also provides an up-todate collection of product news as well as interesting PTV highlights.
With the introduction of the PTV Vision start page, you are now actively notified of new
service packs within the program. The full functionality of the homepage is obtained when
the PTV products have internet connection.
Until the official product release you will only see information about the beta phase on the
start page, but there is more to come.

4.2

Global layout
In PTV Visum 17 we have introduced a global layout that is a file in which the entire
configuration of windows and views can be saved. What is referred to as view includes
both window positions as well as settings for filter, graphics and layouts of all open
windows including the tool windows.
Typically, different ‘global layouts’ are required for different aspects of a project. Users will
arrange their user interface for certain tasks in such a way to make their work comfortable
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and efficient, and this could include: the network editor with its graphic parameters; filter
settings applied in lists; lists used in combination with different editors; procedures
connected to corresponding evaluations in lists; histogram and editors to quickly obtain an
overview of the data and results.
Many individual views have corresponding graphic and layout settings which can be saved
in view-specific file formats, but this concept has now been extended to the entire ‘global’
configuration.
All filter settings, graphic parameters, view-specific layouts, window positions of open views
and tool windows are summarized in a single file and can be transferred to another
scenario or to an entirely other model by reading this file.
Several views are combined in the following screenshot: the schematic line diagram with a
selection of a vehicle journey, the transfer display of connected services with synchronized
selection, the graphical timetable editor synchronized with other views and the tabular
timetable editor. By saving and transferring the global layout to another variant the
analyses can easily be carried out in the same fashion without having to every time
rearrange the windows individually.

Completely different use cases arise for private transport where e.g. data input is made in
the junction editor and the effects are visualised in connection with neighbouring nodes.
The following figure shows: the network editor with the corridor of interest highlighted; the
time-space diagram with the sequence of signalized junctions along this section; the list of
signal controllers and the junction editor. The settings of the junction editor open in the
version file are part of the global layout file too, but can now also be saved separately.
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The existence of referenced network objects e.g. in filter settings or in selection in editors is
a precondition for successfully transferring the global layout to another version file.

4.3

3D Information signs
The 3D network view offers the possibility to present and record your model data in an
attractive and intuitive way. Information signs now offer the possibility to enrich the
presentations with further information. Information signs can reference to all network
elements and display their attributes as well as user defined text. This not only improves
the orientation in the network, but also increases the possibilities in displaying content.
Information signs can be inserted in the 3D network view, but they are also dynamically
displayed during a storyboard.
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4.4

Direct editing of graphic settings
The visualisation by link bars is one of the most popular ways to present the results of
traffic modelling. In combination with the legend, they are often used in official result
presentations. In Visum 17, it is possible to access the corresponding graphic and legend
parameters directly from the network editor.
To access the graphic parameters, the user can now simply hover with the mouse over a
(sub-) line bar and rest there for a moment. Then a button appears which opens the
parameter dialog. The same is true for link bar labels and their parameters.
The interaction with the legend allows even a direct editing of the legend parameters in the
network editor. So it is now possible to adapt legend headings and to set font sizes. The
interactive changing of spacing and margins is particularly helpful.
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4.5

Menus
We have restructured some menu items. The main motivation behind the changes are
specifications from common user experience guidelines as well as from the first evaluations
of data from the user tracking. The ‘Edit’ menu as well as the ‘View’ menu are extensively
changed. The entries for opening several views have been moved from the ‘Edit’ menu
under the ‘View’. In both menus the dynamic parts, i.e. those that change based on the
selection of network objects, have been removed. Likewise, some rarely used menu items
such as the access to the measuring tool as to the history of the window sections have
been removed. This functionality is accessible via the tool bars in the corresponding views.
In the ‘Edit’ menu direct access to various network objects as well as linked options is
possible.
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In several menus the order of the entries have been changed. The aim was to allow for
easier access to frequently used menu entries. The most prominent example is the entry
‘User-defined attributes’ which is now placed in the menu ‘Network’ directly under ‘Network
statistics’. In the view-specific menus that appears next to the ‘Help’ menu for the currently
active view the entries have largely be unified and also rearranged so that more frequent
used items are listed first.
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5.1

Analysing PuT connecting journeys
The quality of a timetable from a public transport user perspective is defined not only by
short travel times and high frequencies, but also by coordination of connecting journeys.
The tool window "connecting journeys" was introduced in Visum 16, showing all incoming
and outgoing connections, as well as those that are reached or missed between vehicle
journey items.
This concept has now been extended so that it is possible to create up-to-date lists of
reached and missed connections and to compare them with other scenarios. The
synchronization of these lists with the network editor and other views gives you a good
overview of the effects of timetable modifications.
In addition to the large-scale analysis of the connections and their effects on the overall
network, the transfer display provides a detailed overview of the connecting journeys at the
individual stop.
With Visum 17 a lot of extensions and improvements to the transfer display have been
made, including uniform scaling of the bar widths, and functions for display and handling. A
new mode has been introduced, called ‘display of connecting journeys’, which indicates the
reached connections for a marked vehicle journey item and displays the transfer flows.

5.2

Isochrones backwards
Based on user feedback, the calculation of private transport isochrones is now also
available ‘backwards’ starting from a destination. Like for the search from an origin, the
coloring of link sections is based on the route search criterion and taking the link length into
account, i.e. sections of links can appear in different colors.
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In the dialog for the isochrone calculation the options for the search directions have been
added. The calculation is automatically updated when switching to the other option.

5.3

Accident prediction model estimation
Using the Safety module it is possible to import accident data and assign the information to
the network. The new Safety Add-In ‘Generic Accident Model’ allows a simple statistical
model for the prediction of accidents at junctions and roads to be estimated using historical
accident data. For the generation of such a model the partial network and active accident
data only are taken into account.
If the number of expected accidents at single locations are considerably smaller than the
actual numbers this points to accident black sports which can be mitigated by changing
local conditions.

Actual accidents at node in a calendar year

Generated Accident Model:
unknown: exp ( 64 + .0000049 V + 0.35 n – 0.03 t)
signalized: exp (228 + .0000193 V + 0.25 n – 0.11 t)
roundabout: exp (159 + .0000035 V + 0.54 n – 0.08 t)
V: traffic volume, n: number of legs, t: calendar year

A generated accident model can be applied to other networks, also without historical
accident data. By doing so, the effects of measures upon road safety can be evaluated for
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several scenario cases. The integration in the procedure sequence allows the current
assignment result to be taken into account.
Various network attributes can be used as input. The selected attributes are either used as
model variables in a generalized linear model (GLM) with negative binomial distribution, or
result in a case distinction in different GLMs depending on the characteristic of the
attribute. In addition, the calendar year of the accidents can be used as a model variable
allowing temporal trends to be modeled. Since the actual state of the infrastructure at the
time of the accident is relevant for the generation of the model infrastructure and accident
data of past years can also be imported from other Visum networks.
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6.1

OD-Import
More and more systems are providing data on the origin and destination of their users'
trips, including electronic public transport electronic check-in / check-out systems, vehicle
sharing systems that indicate renting and return locations, GPS and mobile network data.
The "OD Import" add-in can import those data, given in any csv format, into traffic models,
generate demand, and skim matrices. The user can determine the location reference as
well as the time and content segmentation. Attributes of the input data can be allocated for
aggregation and segmentation. Coordinates are mapped to zones and travel times are
calculated by evaluating the time stamps.
A large number of skim and demand matrices are generated from existing electronically
collected data and can be used as an important base for validating your traffic model.

6.2

Line blocks in railML
In Visum 17 the railML Import has been extended to also consider line blocks. This
enhancement allows you to integrate a further component of operational planning from
other system seamlessly in your traffic model. To transfer the line blocks it is currently
necessary to provide a full data set, consisting of the information of line blocks as well as
the vehicle journeys.
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6.3

Infrastructure export to railML
The railML export supports the macroscopic representation of the infrastructure in railML
2.2. The export includes nodes with additional attributes, routes, and turns. The export
takes into account optionally filtered Visum network objects so that the scope of the export
can be tailored to the application.

6.4

Changes to the COM-API
The COM-API has been extended by some functions, only the most relevant changes are
described here. Please refer to the Release Notes for a complete list.
 All network object container classes such as Visum.Net.Links,

Visum.Net.VehicleJourneys etc. got extended by a new method FilteredBy(<formula>).
This method expects a logical expression in common formula semantics as a string
argument. It returns a new container containing only those network objects for which the
expression returns ‘True’ or a non-zero value.
 When printing is invoked through Visum.Graphic.Plot it is now possible to specify the
printer to be used. The same functionality is also accessible as Visum.Graphic.Print
 The functionality for saving data to various file types was extended by variants allowing
to specify the tables and columns to be saved directly through COM.
 Some obsolete functions have been removed from the COM-API:
► The redundant methods Visum.Net.ODMatrices, Visum.Net.SkimMatrices,
Visum.Net.AddODMatrix, Visum.Net.AddSkimMatrix, Visum.Net.RemoveODMatrix,
Visum.Net.RemoveSkimMatrix for managing matrices have been removed.
► The methods Visum.CreateMatrixTable, Visum.CreateMatrixTableListMode
Visum.CreateMatrixHistogram are now only accessible through Visum.Workbench
► The obsolete methods Visum.WriteToTrace, Visum.WriteToError,
Visum.WriteToMessageFile, Visum.WriteToLogFile for logging outputs got finally
removed. Now all outputs need to use Visum.Log.
► The void method Flowbundle.Save was removed. Call the Save-of the generated
flowbundle-matrices instead.

6.5

Update of Python-libraries
The Python libraries shipped with Visum which are used by AddIns and custom scripts
have been updated to the most recent compatible versions. The Python-Engine itself has
not been updated and remains at Python 2.7.3-0.
New library versions are






omx
dateutil 2.6.
matplotlib 1.5.
pyparsing 2.2.0
numexpr 2.6.2
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numpy 1.12.0
osgeo
pyproj 1.9.5.1
pytz 2016.10
tables 3.3.0
pandas 0.19.2 (new)
wyPython 2.9
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7

Technical changes
PTV Visum 17 will no longer operate on the Microsoft Vista operating system which is no
longer supported by Microsoft. Furthermore, no 32-Bit variant of PTV Visum 17 will be
provided, as meanwhile almost all customers work on 64-Bit platforms.
The operation of network licenses was made more robust through a series of measures,
e.g. by introducing a latency before searching for fallback license servers in case of lost
connections. This reduces impacts of short network disruptions. Also, the license
acquisition at program start now works faster.
The CodeMeter Runtime deployed with PTV Visum was updated to CodeMeter 6.50a.
During the installation, an update of the dongle firmware may be triggered.
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